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e EM-Core is a time-domain Field Solver Softwaréor planar circuit, 2.5
dimensional circuit and antenna simulation.

 Thetoolis a cost effective, proven, very accurate and easy to use
electromagnetic simulator. It can be used to simulate structures such as
filters, couplers, spiral-inductors, meanders, antennas and active
manifolds.

e EM-Core can simulate 3Dradiation patterns, antenna gain and efficiency,
as well as S-parameters.

 In EM-Core, RF designers can build their structure from scratch using the
chip designer icon or import it using the DXF import feature

e EM-Core can model substrate and metal losses, by setting their
appropriate values using the tool's setting option.
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3D ShortCut Keys
<ALT>-A
<ALT>-Z
<ALT>-Y

<ESC>

<DEL>

<CTRL>Z
<CTRL>Y
<SPACE>
<LEFT-MOUSE>

Useful shortcuts

Auto-Rotate 3D model by 360 degrees (press once)
Zoomin 3D model (press and hold)

Zoomout 3D model (press and hold)

Finish AutoRotate or Finish Component Insert Mode
Delete Component

Undo last action (insert or delete component)

Redo last action (insert or delete component)
Rotate model by 90 degrees while adding Ports
Drop Port or Component

2D ShortCut Keys (while in Edit Mode)

<DEL>

<ESC>

<CTRL>Z
<CTRL>Y
<CTRL>-C
<CTRL>V
<CTRL>-X
<CTRL>D

Delete currently selected metal

Finish drawing Fre®raw metal shape and join last point to first
Undo last move or stretch operation

Redo last move or stretch operation

Copy metal into buffer

Paste metal from buffer

Cut metal into buffer

Duplicate metal (equivalent to <CTRLS and <CTRL>V)
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The EM-Supreme/EM-Core interface has been designed to help simplify your
project design experience.
A Main drop-down menus

File Edit Addltemn View Chip Designer Options Windows Help

The File drop down menu will give you
the ability to start a New Project, ;
<«——— Open an existing Project, Close your 1

[ MNew...

G2 Open Project... Undo Ctrl+Z &— The Edit drop down menu enables you to

Undo or Redo your actions.

SR e current Project, or Save your Project.
Delete DEL o A selected component can also be deleted.
Save Project fs... You will also find the option to Import
Import DXF... ¢—————— and Export DXF.
Export DXF...

o RESistor

- Capacitor
oo Inductor

;_{5 Pin Diode

You can also choose to print your

1

1

1
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1

1

1

1

1
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| 1
Brint... < current 3D design. !
Exit !
1

1

1

1

1

1

1

1

1

I

I

1

1

Your recently opened Projects will also

Ch\Program &—— .
. be listed below.

C\Program &= Bond Wire \
Untitled\Untitled.emc T Port
Ch\Program The Add Item menu gives you the option to

omariomar.emc choose from several built in components to

be added to your design. These components
can also be accessed by clicking on their
corresponding quick link symbols below.
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You can set the unit for length

The View menu lets you perform several to mm, cm, Microns, or mil.

functions to your 3D design, such as

o Zoom Zooming, Rotating, etcX To do so, simply Units / SHEERL_X_
iy Rotate select the action that you would like to
¢ Pan +— perform, then click on you 3D design, and S [ ¥ &
F Expand move your mouse accordingly. These \
3 b | fnctons can o e s by o e 5

below P &4 y Capacitance pF

) Inductance nH e

The Chip Designerwill enable you to draw Resistance | Ohms
B Draw Metal 4 and design Your me.taI. in 2D \{lew. You <?an

also access it by clicking on its quick link

symbol below. To learn more about this
feature, please go to the Draw Metal
section in this manual.

Settings The Options menu gives you access to
Units change the Settings and the Units as
discussed below.

The units for Frequency, Capacitance, Inductance,
and Resistance are set by default and cannotbe
changed.
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/ KFy3s &2dzNJ ylh Fr8ayen véRanﬁés set from 1t0 20 GHz by default,
ut can be set accor

ing to your project requirements.

Settings

Metal Parameters
Color Selector Freq. Range 1.00 to | 20.00 GHz Frequency Swee, 1.000 GHz
J’ Bridge Depth (nDy) | 3.000 SRR SEErE ?

[

> Radiation Mo = Substrate Loss Tangent | 0.00000
‘L Line Width (mm) | 1.000 —> o <
> Forts Single = Port Reference (nDz) | 10.000 ¢

> Metal at Bottom  |Ho -

Large-Signa No -
Metal Thickness (mm) | 0.00000 —>
Mesh Density 20.000 cells/wavelength
Conductivity | 0.00000 sim

f

v Show 2D Grid
<+— Select to show a 2D Grjd Set your Mesh Density o |

The Bridge Depth and Line Width are set by Control simulation for Large-Signal or
— default, but can be changed according to Small Signal Parameters. Set the Port Reference for de-—
your specifications. embedding S-parameters. It is set
[ You can choose to have Single, to 10 by default. The value chosen
You can choose to have a Metal at the bottom Differential, or Common Ports. must be greater than 10.

~ of the substrate.

You can choose whether
The Bridge Depth and Line Width are set by —  or not you want radiation. Set the Substrate Loss
L__ default, but can be changed according to Tangent (0 by default).

your specifications.
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v 20 Graphics

v Properties

v Log

v Control Panel
Bestore Default Window Positions

[ PedaSoft EM Core v3.00 - |n itled Project
Fle Edit Addltem View| fhip Designer Options Windows Help
@S o|f s v af@en

MR

The Windows drop down menu lets you
enable or disable specific windows in your
work area. You can also restore to the
default positions after making unwanted
changes. These windows are explained in
greater detail later in this manual.

e

ax=  0.50564985

bx [ 038300000
by  [0.26405989
z [ 0.20000001

== ==
Domain Propsrties
ame Boxl
b 19,4500
Iy 42400
iz 26,0000
h 0.7950000

epr 2.200

Component Properties
Name

Startx

Starty

Startz

Endx

Endy

Endz

From Metal

To Metal

=

|Hold left mouse down and pan shape in any direction
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A Control Panel

=1 =|

@ Model

Simulation

Max = 0.505645936

D= 0.38500000

Dy 0.264555999

Dz 040000001

»  Quick Links Toolbar

Sawve your
Starta Project
MNew .
Project l Prmt

Opena T
previously Undo
saved Save and
Project your Redo

Project

with a
new
name

<4—— Click here to start designing your Model.

After finishing your design, and adding all the
<4—— hecessary ports, you can then click here to

run the Simulation.

<«—— When the Simulation has ended, you
can then click here to view the Results.

You can then also click here to view the

‘ Radiation Pattern.

<4—— Max value of Dx, Dy, and Dz.

Delete
Selected
Component

Cont.

Zoom, Rotate, Pan,

and Expand your

30 Design

Adda
Resistor

f

Inductor

Stop
Current

Reset
Component
Mode
Bond
Wire

F|j:' o E 8 DW—||—-"-'-'-"-¢.§;\“@1

Simulation

Reset C:‘dd_: Port .
your pacitor D Ch'p
o
EhEﬁgES E5IENET
h Mode
to the Pin Diode
View
A Properties Panel
==
Domain Properties
by 4.240
Ih 0.795
epr 2.200
| 50.000
Component Properties
MName Resistor1 ﬂ
Walue 1.000

You can change the properties of
your domain by clicking on each
corresponding cell, and inputting
the desired value.

You can edit the properties of all of
the components that you are
currently using.

First click on the drop down menu,
then select the desired component
from the list.

You can then start editing/changing
all of the desired values for that
particular component.
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A Chip designer

Cont.

In Chip Designer mode, you can easily draw and design your metal in 2D, using basic
geometric shapes, freehand, or built in shapes such as spirals and bridges.

File Edit View AddIem Windows

The File drop down menu gives you the
ability to save the changes to your metal
D design, and to display the Geometry File.

Save Geometry
Save Geometry to File...

Close Window «— By Closing the Window, you can get out
of Chip Designer Mode.

E Change Grid Dimensions...

v

The Edit menu gives you access to entering Edit
Mode, where you can edit your metal designs in
greater precision, by setting their exact location,
and changing their geometric properties.

You can also Cut/Copy, Paste, Delete and Duplicate
a selected shape. The D NJA DRnf2@sions can also
be set here.

foom in

v

The View menu lets you Zoom in or out, by first clicking on Zoom
in, then selecting the exact area that you would like to zoom in to,
and Zoom out to go back.

Rectangle

Triangle

Circular &rc

Harizental Bridge
Vertical Bridge

Circular horizental Bridge

Circular vertical bridge
Square Spiral The Add Item drop down menu has a list of geometric
shapes and predesigned built in shapes for your metal

Circular Spiral ! . ;
design needs. Just click on the desired shape, and set

Lange its location and size on the grid by clicking and
Meander dragging.

InterDig

Ean 5tub

Yia

FreeHand Shape
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A Chip designefuickLinks

Switch

between  Duplicate a
real or grid selected
coordinates  shape (in

Open -
Geometry Cut, Copy, Paste Enter Edit Edit Mode)
File a selected object Mode l

y —M
= H JEI E o R ._'_IE B E O

Draw
Vertical

Circular

Draw Fan
Stub Draw
FreeHand

Draw n-
Sided Draw
Spiral Meander

v

! * |
m > u][%glﬂ@@@%%Q@\

Save T Change
Geometry Zoom in/out Grid Deleted
File Dimension Metal
s Object (in
Edit Mode)
Draw
Draw Ver:;ical
Bridge
Square/ Draw & Bridge
Rectangle Circle l
Draw T T
Triangle Draw Draw

Horizontal Horizontal
Bridge Circular
Bridge

Draw

Square
Spiral Object

R B

Draw Draw Draw Via

Lange InterDigCap Select
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A Design procedure

0 Step 1: Click on Model to start the design
0 Step 2: go to Options A Units, set the unit mm, then go to Options A4
Settings make the following settings:

Metal at Bottom: Yes; Radiation Yes, FrequencyRange 1 to 18 GHz

0 Step 3: Set Dx=0.48, Dy=0.265 and Dz=0.5 at the control panel

Metal Parameters

Bridge Depth [nDy) ,W Dl el iz, Rl ’W to |20.00 fiHz Frequency Sweep ’W GHz
Line 'wiickh [mm] ,mni Radiation | Tes he Substiate Loss Tangent 000000
Metal atBottomn | Yes 7| Forts | Single s Part Fieference [rDz) ,W

Metal Thickness (mm) ,W LargeSighal Mo s
Conductivity (200000 10% S/m Mesh Density |20.000 cells/wavelenath

0 Step 4: go to Chip Designer, select Change Grid Dimensions, and set the
dimensions 56x90

0 Step 5: start the metal design by going to Edit Mode, and the complete design,

At the end, your metal design should look like: o
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0 Step 6: go back to control panel, and add one ports to finalize the design

0 Step 7: by selecting No for large signalin Settings, we can run the
small signal simulation for this design
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0 Step 8: Click on Resultsto check the simulation results: you can check the results
in both rectangular and smith chat views. You also can check the far field response by
clicking on RadiationPattern

Freq.(511) = 7.334 (re = 0.066323 , im =-0.074892 )
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0 Step 9: Users are free to play the design parameters. For instance, we can move
feeding line 3.5 dx right to its original location.

-

20 FregqS11)=  0.114{re =1.007320,im =0.260199 }
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The performance of higher frequency band is improved.
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A Design procedure (square spiral case)

0 Step 1: Click on Model to start the design
0 Step 2: go to OptionsA Units, set the unit Microns then go to OptionsA4 Settings
make the following settings:

Metal at Bottom: Yes; Radiationt No, FrequencyRange 1 to 100GHz Bridge

0 Step 3: Set Dx=10, Dy=33.3 and Dz=10 at the control panel

Metal Pararmeters
Bridge Depth [nDy] ’73 o0 Caolor Selector Freq Range |(1.00 to [100.00  GHz Frequency Sweep [1.000 GHz
jjon (No 7] 0.00000
Line width (Micrans) |20.000 Fadiation o Substrate Loss Tangent
Ports ISingIa—'I Part Reference [nDz] [10.000
Metal at Bottor | Vs -
LorgeSignal [Me =]
Metal Thickness (Microns)  |0.00000 EUEREA e
i 20.000
Conductivity [0.00000  10¢ S/m Mesh Dermity cells/wavelength

0 Step 4: go to Chip Designer, select Change Grid Dimensions, and set the
dimensions 35x40

0 Step 5: start the metal design by going to Edit Mode, and the complete design
for this case looks like:
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0 Step 6: go back to control panel, and add two ports to finalize the design

0 Step 7: by selecting No for large signalin Settings we can run the
small signal simulation for this design

0 Step 8: Click on Resultsto check the simulation results: you can
check the results in both rectangular and smith chat views.

o Freqs11) = 2.000 { re =-0.053165 , im = 0.016398 }
— 511 Freqs21) = 2.000 { re =0.904070 ,im =-0.047299 } i
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0 Step 9: Users are free to play their design parameter to achieve an optimal design.
We are going to change the bridge depth from 2 Dy to 4 Dy.

-v v

Freg.511)=  2.000 {re =-0.025434 ,im = 0.012369 )
=== Freq(s21)=  2.000 {re=0.954740 ,im =0.050410) =

2o

14
R

dB
=
a

4 (%3

o

Freq(GHz)

The performance of higher frequency band is improved.
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e To sum up, , EM-Core is a cost effective verified, very
accurate and easyto-useelectromagnetic simulator.

e Especially fits for planar circuit, 2.5 dimensional circuit and
antenna simulation.

e EM-Core will help vyou reduce design cycles and

ultimately time-to-market as well as product development
cost.
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Thanks!



